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Now... “PABERDEEN

 Anyone who has not set up their account in advance?

* If yes—afew minutes now to do so — see Quick Guide Step 1

* Does anyone use LaTeX?

* |s anyone using a Footnotes referencing style?

 Will anyone be using a Mac?



RefWorks and Mac computers
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Important note:

The Write-N-Cite (WNC) plug-in for RefWorks does NOT currently work with Word 2016 on
Macs

RefWorks are working on a fix for this (in)compatibility issue — unfortunately there is little
that we can do to help until a solution is in place

* You can still store records in your main RefWorks account, but you cannot use the WNC
app to format them within Word 2016 when creating/writing a research paper or other
academic document

* If you have access to earlier version of Word — could use this with the WNC app for
creating/writing a research paper or other academic document that requires in-text
citations

An alternative is to use the One Line/Cite View method. Details available online and more to
follow later in this session:
www.refworks.com/refworks2/help/Using One Line Cite View.htm



http://www.refworks.com/refworks2/help/Using_One_Line_Cite_View.htm
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Aims and Objectives Ref

* Aims
* QOverview of referencing systems
* Bring references into your RefWorks account
 Demonstrate various RefWorks features
* Create a simple bibliography
* Use Write-N-Cite to create a paper with in-text citations and a bibliography
* Allow time for practice

* Objectives
 Familiarity with the basic functions of RefWorks

* Produce a formatted document with in-text citations and a bibliography in a
style of your choosing
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Reference Management Software “PABERDEEN
 Can make the physical process easier NS
* Need to invest time in learning how to use properly \\\l\

* Referencing option within Word

e Cite This For Me, Zotero, Mendeley, CiteULike — free, web-based

 EndNote, ProCite, Reference Manager, Papers — purchased, machine
specific

 RefWorks — free (because we have paid for it), web-based, instructional
sessions and support

* You still need to understand and know:

 why and where to reference

* preferred style (strict or some flexibility?)
Style — check with supervisor on preferred style
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What is RefWorks?

* Web-based — access from any computer with Internet access

 Two functions:
* Electronic store/filing cabinet
 Formats bibliographies

* Your own database of references

* No limit to number of references in your RefWorks account



What is Write-N-Cite (WNC v.4)?
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* WNCis a plugin for Microsoft Word which allows you to insert citations
you have saved in RefWorks directly into the text as you write

 Formats in-text citations automatically and creates a bibliography at the
end of the document in a chosen citation style

 Opened from a tab in Microsoft Word application

* Already instal
* You may heec

* You can instal
Worksheet

ed on classroom PCs
to install to your office PC (from the Software Center)

to your personal PC/Mac (from RefWorks). See Part 2



RefWorks can easily create a bibliography
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@® RefWorks

Search Your Database

& New Folder [ create Bibliography

3 New Reference

Create a bibliography fr m a list of references

s

@) Selecte
MNeed Help creating a bibliography? Did you want to format 8 paper and bibliography instead of creating a bibliography from
i a list of references?
-.,3'} Manage Cutput Styles Create Bibliography
i
PR 1 AR LA AT A A AU AL 1Rt LE A s . GLOLY G L L
Source L2011, 24, 2, 171-195, Institute of Economic Research, Seoul, South Korea,
Seoul
Folders
RefID 3876 Journal Article Reference 4 of 16 {
AL
Authors

Title Indoor environmental quality in a dynamic life cycle assessment framework for whole buildings: Focus on

human health chemical impacts

Source , 2013, 62, 182-190
Folders i
ReflD 3878 Journal Article Reference 5 of 16

|
(9]
(=3
4
»

-

University of Aberdeen
Welcome, Elaine Shallcross.

& 4 Search

Announcements

Resources

| T]

Folders a
puzilngs=s SLnaur 1)

Coaching Culture (7)
» Documents (0}
Finance (5)

Katie Stearman (4)
Leadership (1)
Marketing (10)

MBA workshop (24)

Problem Examples (1)

Real Estate (16) i

Quick Access

Statistics




File Home Insert Page Layout References Mailings Review View Developer Add-Ins Ref\Works ~ 2
= . - = Find ~ -
| K & | A | B . NG RSITY OF
= erdann A A A B == T AaBbCcl AaBbCI AaBb( AaBbC AaBb( AaBbCcl s Replace o
4 +AG
Paste = = abr . o = i i i i r Change
. o Format Painter I U -~ abe x, X g A TMormal T Mo Spaci.. Headingl  Heading 2 Title Subtitle | — Stylesg' s select~ RDEEN
Clipboard Faont Styles Editing
B vl -t -2 1 -3-0 4.1 51 6B 1 -7 1 -8B 0 9 1 10 1 11 1 12 1 13- 1 14 | 15+ | 16 1 17 | 18 1 19 | 20 | 21 1 93 | 23 1 94 | 25+ | 26 1 37 | 2B 1 29 | 30 | 31 132 1 L[
r
Ahrnet Se k D Zkirici 2012, "Considering Istanbul As A Financial Center: Targets, Following Steps”, International Journal of Business and Social Science, vol. 3, no. 18, pp. hfa.
"Political Econcfghy of Cross-Strait Investments: The Taiwanese High-tech Industry as an Example”, Seouw! Journal of Economics, vol. 24, no. 2, pp. 171-195.
N dis, A.E., Jones, AK., Schaefer, L.A. & Bilec, M.M. 2013, "Indoor environmental quality in a dynamic life cycle assessment framework for whole buildings: Focus on hurman health
chemical impacts”, Building and Environment, vol. 62, pp. 182-190.
Dai, Q., Duan, 5., Cai, T. & Chen, C. 2013, "Plug-in electric vehicles as dispersed energy storage interactions with a smart office building”, Journal of Renewable and Sustainable Energy, val. 5, no. 2,
pp. 021417.
Dermisi, 5. & McDonald, J. 2011, "Effect of "Green” (LEED and ENERGY STAR) Designation on Prices/sf and Transaction Frequency: The Chicago Office Market”, Journal of Real Estate Portfolio
Management, vol. 17, no. 1, pp. 39-52.
Dodo, Y.A., Kandar, M.Z., Qssen, D.R., Jikrl, 1.0., Bornoma, AH. & Abubakar, A.l. 2013, Importance of a view window in rating green office buildings.
Ealkenbach, H., Lindhalm, A. & Schleich, H. 2010, "Review Articles: Environmental Sustainability: Drivers for the Real Estate Investor”, Journal of Real Estate Literature, vol. 18, no. 2, pp. 203-223.
Ho, K.H., Rengarajan, S. & Lum, ¥.H. 2013, ""Green” buildings and Real Estate Investment Trust's (REIT) performance”, Journal of Property Investment and Finance, vol. 31, no. 6, pp. 545-574.
Lahm, R.1.,Ir, Stowe, C.R.B. & Geha, P.R. 2011, "Commercial real estate (CRE) market - next meltdown or recovery on the way?”, Research in Business and Economics Journaf, vol. 4, pp. 1-17.
inefine and Gas Journal, vol. 240, no. 1.
iy, A.D., Gawver, B.M., Macdonald, I.A. & Burns, G.J. 2013, "Do "green’ buildings have better indoor
Thiel,.C.L.., Campion, M., Landis, 4.E,, Jones, A.K., Schaefer, L.A. & Bilec, M.M, 2013, "4 materials life. cvcle asse = ilding” i -
Wang, Z.& Tan, Y.K.. 2013, Humination.control.of LED systems based.o
Yun, R., Scupell, P., Aziz, A. & Loftness, V. 2013, Sustainability in the workplace: Nine intervention technigues for behavior change.
w
E
o
¥
Words: 434 | <5 | | B E[R] = U (x)




Now...

™ UNIVERSITY OF
P ABERDEEN

 Anyone who has not set up their account in advance as previously
requested?

If yes — a few minutes now to do so — see Step 1 in the Quick
Guide

Those who have an account — log in to it. Can you remember
your login name and password ? ©

Please create a new folder in RefWorks following Step 2 in the
worksheet Managing References — RefWorks Part 1

Once you have created your new folder please log out of
RefWorks



Creating an account if you are on campus

® RefWorks

Create Account

Step 1: Step 2: Finished =
Account Information User Information Enjoy RefWWorks!

Create an account at University of Aberdeen (not my institution)

Email Address: | e_shallcross@abdn.ac uk

Fe-enter Email
Address:

Login Mame:

Password:

Re-enter Passwaord:

1 * Complete the form

* Click on Next button

' Confirmation email will be sent from

Refworks
| *Save this email as it contains the Group Code
for off-campus access

Copyright 2013, ProQuest LLC. All rights reserved. | Contact Us




Creating an account if you are off campus

.
® RefWorks * To create an account from off-campus you will be asked

to enter a Group Code
Fritiod = * To obtain the Group Code go to

Create Account

ccount at University of Aberdeen (not my institution)

stess s shllross @b ac e _ . Log in with your University username and password
‘  Scroll to find the entry for RefWorks — take a note of the
code. It is case sensitive

0 »-e_:B_rr:|---»;!'-.-'E!r| ::;E; iﬁ'_-.-'ite-:‘ 'E-:l r::a_riin::i[:::atée_i-n :E:E:él::i:ai E!'-.-'»;!nté:. )

* Complete the form

* Click on Next button

* Confirmation email will be sent from Refworks. Save this email as it contains
important login information you will need again.



Getting references into your RefWorks account
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Populating your RefWorks account 9 ABERDEEN

 Variety of methods depending on source used:

* One step — export on click of button from the major databases including Scopus, Web of
Science, ProQuest and EBSCO

* Two step — save references and then use import feature within RefWorks to pull records
in. OnePetro is main example of this

* Adding references from Primo is different — demonstrate later
* Manual input — find out the intricacies of being a library cataloguer ©
« We’'ll look at 1-step process today

 Forimportinstructions for popular databases refer to Methods for Importing Records
guides available today

* Forimportinstructions for all UoA databases see

www.abdn.ac.uk/library/documents/guides/importing.pdf



Example search

Remember (from workshop Part 1 & 2) — plan your search terms:

“Discuss the impact of rapid long distance
travel on the sports performance of athletes”

™ UNIVERSITY OF
S ABERDEEN

Concept/ldea 1 athlet* OR sports*
AND
Concept/Idea 2 “jet lag” OR jetlag
AND
Concept/ldea 3 | “circadian rhythm*” | OR | “sleep disturbance*”




Practical Session

NIVERSITY OF
BERDEEN

Please follow the steps in the worksheet Managing References — RefWorks Part 1.

Start at Step 4: Import references to RefWorks from the Scopus database

|Managing References - RefWorks Part 1
Information Skills Practical Workshop

Refilor|
refere

ks is a Web based bibliographic management software package that allows you to store and manage your
nces, and create correctly formatted assignments and bibliographies.

Once you complete Step 4 please complete Step 5 (Exercise 2), where you import
further references from another database. We would recommend Web of Science.

You will need at least 10-12 references in your Refworks account for work we will do
later in the workshop

PLEASE ASK FOR HELP IF YOU ARE UNSURE WHAT TO DO. WE ARE HERE TO HELP YOU!



For the best possible results — apply the search rules for Scopus

Search Sources Lists SciVal ® A E Create account

Docu ment S‘ea rCh Cl:lmpare sources >

® Documents Authors Affiliations  Advanced Search tips (3

Search
athlete* OR sports* X  Article title, Abstract, Keywords +

Search
X  Article title, Abstract, Keywords — |t

“jet lag" OR jetlag]

> Limit

Reset form




Select the records you wish to store in RefWorks by using the

M tick-boxes alongside each entry. Click on Export

- i Scopus

135 document results

Search

Sources

Lists SciVa

Create account

E-ABS-KEY ( athlete® OR sports®

& Edit |9 Save L. Setalert

Search within results...

Refine results

Access type (@

Open Access

Other

Year

2020
2019
2018
2017

2016

AT

Set feed

Documents  Secondary documents  Patents

0o Analyze search results

Show zll abstracts

Yiew Mendeley Data (31)

Sort on: Date (newest)

A Download  View citation overview  Viewcited by  AddtoList  wes = = T

Document title Authors Year Source Cited by

Body Clocks, Jet Lag, and Sports Performance: The Times of Our Lives Eichner, E.R. 2020 Current Sports Medicine 0
Reparts
1%1), pp. 1-2

«» sina we Related documents

Effects of training and competition on the sleep of elite athletes: A systematic review and meta-analysis Roberts, 5.5.H., Teo, W.-P., Warmington, 2019 British Journal of Sparts 10

Open Access S.A Medicine
53(8), pp. 513-522

View abstract~+ «=»eina »e Related documents

Nutrition for travel: From jet lag to catering Halson, 5.L., Burke, L.M., Pearce, ). 2019  International Journal of Sport 1




Select RefWorks direct export and choose the information to

export to include the abstract if it is available

Export document settings @ X
You have chosen to export 3 documents

Select your method of export
28 MENDELE] @ exibils
RetWorks

What information do you want to export?

B Citation information Bibliographical information B Abstract & keywords Funding details Other information

Author(s) Affiliations Abstract Number

RIS Format CS5Y BibTeX Plain Text
EndMote, Excel ASCH in HTML

Reference Manager

Tradenames & manufacturers
Document title Serial identifiers (e.g. ISSN) Author keywords Acronym Accession numbers & chemicals

Year PubMed ID Index keywords Sponsor Conference information
Source title Publisher

volume, issue, pages Editor(s)

Funding text Include references

Citation count Language of original document
Source & document type Correspondence address

DOI Abbreviated source title




Select Export to legacy version of RefWorks

Continue exporting to RefWOI'kS ?

Yes, export to the newest version of RefWorks

Ly RefWorks

No, export to the legacy version of RefWorks




Log in with your RefWorks account details

® RefWorks

Mew to RefWorks?
Sign Up for a New Account

Login using RefWorks Credentials

Login Mame

ewanag

Fassword

Keep my session open
for 14 days

Forgot Your L ogin Information?

Login using Other Credentials

Jpen Athens Credentials

My Institution’s Credentials (Shibbolethy ¥

RefWorks Terms and Conditions

Want to learn how to get the most out of RefWorks?

Simply download our Cuick Start Guide and you'll be using RefWarks in no time! You can also check out our great

series of videos to learn how to quickly navigate through the basic RefWorks features. For more detailed

information participate in one of our free live fraining sessions or view one of our many webinar recordings.

L] W Copyright 2016, ProQuest LLC. All rights reserved. | Contact Us




Check for errors — view Import Log

University of Aberdeen
. RefWorkS Welcome, ewanag.
Search Your Database S Search
Import References
g New Folder | | [
=l
References > AllR
* Import Log
| References * Duplicate Checking Options
Refzrencas|
® Szlacted Pag =]
RefID 350
er  (57)
Title, Primary  Gr :
KR ed (4)
Source % Ry test (10)
Folders wo sh (32)
RefID 271 {20}
Title Fis ler (0]
Source PFH _
(45)
ReflD 42
ssay (8
Title P 0 (5)
Source Thi - &
RefID 215 a
Authors Ab| kearch
Title  Int
Source Au| L .
Folders spl E_| View Duplicates | View Last Imported Folder
A
REHD 2?2-\.! YUUTITAT TV LT TYCETETETIVE T UT JJU0 Iv—é;; O & &‘.& N : :
E Create Bibliography
Authors Abimbola.M.; Khan.F,; Khakzad N. =
Title Risk-based safety analysis of well integrity operations |.“.;.'] Print References




Most cases — no error messages
Click on View Last Imported Folder button

University of Aberdeen

. Refworks Welcome, ewanag.

Search Your Database . Search

Import References

o NewFaolder | | [

¥ Import Log

- Import Date  10/24/2016 6:00:58 AM
References

Referances Vendor SCOPUS

® Selected Pagl

Import Filter Direct Export

i * Duplicate Checking Options R

Title, Primary G
Source O

Folders wo
ReflD 271 (20)
Title Fis ler1 (0}
Source PH|
ReflD 42
Title Pr e
Source Thi - -
ReflD 215
Authors  Ab
Title Int

Source Au

Fonaa o E_| View Duplicates View Last Imported Folder

P

[§ Create Bibliography

ReflD 272 TUUTTTET P ICE TR e T e Toe o UT J0 0 I’O:J JF

Authors Abimbola M.; Khan.F; Khakzad.M. =
Title Risk-based safety analysis of well integrity operations =) Print References

" P




Last Imported Folder is the holding folder for all new records

coming in from your searches on databases

Search your RefWorks database |u§ , Search J
Additional Information !
o MNew Folder Create Bibliography =y Mew Reference SEEReLE e | Resources =|
E Support Center
o AMahin =
References = Last Imported p | rEOInArs
 f]
References || Organize & Share Folders | Folders .
References to Lse B Sort by Change View Py
v || ; ; My List
9 selected Page All in List v || X|=e Authors, Primary = Standard View - S
Motin Folder {19)
ReflD 400 Journal Article Reference 1 of 6 3 i
Owla X ’ & Lastimported (6) |
Authors Keats M.R.; Emery,C. A Finch.C.F. acidrain (82) 1
Ll I J
Title Are we having fun yet?: Fostering adherence to injury preventive exercise recommendations in young -
athletes anchorages (260)
Source Spors Medicine, 2012, 42, 3, 175-184 hody image (64)
Folders Lastlmpored; EE— !
Cardiovascular Disease
ReflD 396 Journal Aricle Reference 2 of 6 k[ X ) chapter 1 (2)
Authors Leatherwood W.E.; Dragoo,J.L. chapter2 (0)
Title Effect of airline travel on performance: A review of the literature o
Source Br.JSports Med,, 2012 chapter3 (0) -
Folders Lastimported;
Quick Access =
ReflD 399 Journal Article Reference 3 of 6 3 :
Cwl] X : , Advanced Search
Authors LeeA Galvezr ).C. -
) - I Import
Title JetLagin Athletes
Source Sports Health, 2012, 4, 3, 211-216 4 Export
Folders Lastimported;
@ Create Bibliography
ReflD 398 Journal Aricle Reference 4 of 6 €3k (s7 X ) ¥ Delete References
Authors Samuels.C.H. (&) Print References
Title Jetlag and travel fatigue: A comprehensive management plan for sport medicine physicians and high- e -
perfarmance support teams ¢ Output Style Manager
Source Clinical Journal of Sport Medicine, 2012, 22, 3, 268-273 ] Customize
Folders _Lastlmpoded:




Can create folders in advance, or when you need them

University of Aberdeen

. RefWorks Welcome, ewanag.

Search Your Datahase |u‘f¢ s Search
g New Folder [ Create Bibliography &) New Reference Addiional Informatior _ Announcements
‘::-_-,:’
o  Resources =)
References = Last Iimported =
P ? sy pport Center
Webinars
References | Organize & Share Folders | 1)
Referances to Use Sort by Changs View
® Sglected Page Allin List =
ri (1) -
RefID 2795 ebiwari test (1)
Authors FullagarH.H.K.; Duffig fishy (11)
Title Sleep, travel, and rec
fravel friday test (1)
Source |mternational Journal areen economy  (4)
Folders Lastimported; green economy  (4)
ReflD 2794 hemingway test (4)
o ) language lab (2)
Authors Kélling.S.; Ferrauti A ; PleifferM.; Mevyer.T.; Kellmann .
Title Sleepin sports: A short summary of alterations in sleepfwake patterns and the effects of sleep loss and jet- medline testv2 (8)
lag
Source Deutsche Zeitschrift fur Sportmedizin, 2016, 67, 2, 35-38 nanking (4)
Folders Last imported; picts (28)
. . -
ReflD 2793 Journal Article Reference 3 of 4 (B CIdk [ X :




Record management — filing in folders

University of Aberdeen
@® RefWorks Weicome, cwanag
Search Your Database |~1_‘3 s Search
o MNew Folder |E Create Bibliography &) New Reference Additional Information Announcements
lﬁ
o Resources 2
’ Support Center
Webinars
References || Organize & Share Folders | [l
Referances to Use B Sart by Ehange View
g v |G X2 : : Folders o
®) Selected Page Allin List : Authors, Primary ¥ || Standard View v
N ebiwari (1) -
fishy (11) o
RefID 2795 LT3 7g (] XK 1 ebiwari test (1)
friday test (1)
Authors FullagarH.H.K.; Duffiel s Kélling.S.; MeyerT. fishy (11)
Title Sleep, travel, and reco nomy  (4) luring and after long-haul international air
travel friday test (1)
way 1 4 -
Source [nternational Journal of o ) 2016, 11, 1, 86-95 areen economy  (4)
Folders Lastimported; 0 green economy (4}
- hemingway test (4)
ReflD 2794 s (2] LSE3 15«7 X L E—
L ! jetlag (0)
Authors Kolling.5.; Ferrauti A F (8)
Title Sleepin sports: A shor patterns and the effects of sleep loss and jet- language lab (2)
lag 4 i o
Source Deutsche Zeitschrift fur R medline testva  (8)
Folders Lastimported; nanking (4)
shop (25) = o =
ReflD 2793 I"":{){z 5 ‘.;g L
Authors Jn al-R G Pascoal A; SilvaH-H.; Paiva T Quick Access =

* All records go into the Last Imported Folder when they are first pulled into RefWorks.

 From there you can file, or tag, them into folders you have created.
e Each new batch of records coming in replaces the current ones in this Last Imported Folder




File records in a folder using radio buttons or ] tick boxes

University of Aberdeen
. RefWorkS Welcome, ewanag.
Search Your Database |6@ Y Search
o Mew Folder E Create Bibliography wd Mew Reference Addifonal Information ¢ L Announcements
@ Resources =
References = Last Imported »  support Center
Webinars
References Organize & Share Folders | TR
Refarences to Ligm Sort by Change View
Selectad Page ®) Allin List ©| | Authors, Primary ¥ Standard View v Folders -
- ehbiwari (1) -
ReflD 2795 ideo provides a powerful way t |:é{] | ﬂ s ebiwari test (1)
Authors  FullagarH.H.K.; Duffiel wnctestl &) ; Kblling,S.; Meyer.T. fishy (11)
Title Sleep, travel, and reco cbiwar (11 luring and after long-haul international air
fravel friday test (1)
Source [International Journal of ebiwari test (1) 2016, 11,1, 86-95 I omy ()
Folders LastImported; » green economy (4}
TSN | ]
_ hemingway test (4)
ReflD 2794 e 1) T3 7glsT X :
. . ! jetlag (0)
Authors Kdlling.S.; Ferrauti A ; F e menn .
Title Sleepin sports: A shor : ) patterns and the effects of sleep loss and jet- language lab (2)
lag i S
Source Deutsche Zeitschrift fu medline testv2 (8)
Folders Lastimported; nanking (4)
ReflD 2793 (B €I [s b 4 A
Authors Silva.M-R.G.; Pascoal.A. Silva.H-H.; Paiva.T Quick Access a




Record management - records saved successfully to folder

sogle Scholar M Gmail (5 URL Short

® RefWorks

University of Aberdeen
Welcome, ewanag.

Search Your Database |C€J s Search
& New Folder IE Create Bibliography () New Reference Additional Informafion R Announcements
@ Resources =]
References = [jLast Imported '3

References I Crganize & Share Folders |
Refarances to Use _ Sort by Change View
v |y M . "
Selected Page ®) Allin List & © X&) Authors, Primary ¥ Standard View v

ReflD 2795 Journal Article Reference 1 of 4 =] JER 4 L
Authors FullagarH H K. Duffield R ; Skorski.S.; White D.; Bloomfield.J.; Kélling.5.; MeyerT.
Title Sleep, travel, and recovery responses of national footballers during and after long-haul international air

Sourfe International Journal c@Sports Physioloay and Performance, 2016, 11, 1, 86-95
jetlag;Last Impored;
ReflD 2794

Journal Article Reference 2 of 4

I:é:: 0| &‘i %

Authors Kdlling.S.; Ferrauti A ; PfeifferM.; MeyerT.; Kellmann.M.
Title Sleep in sports: A short summary of alterations in sleepfwake patterns and the effects of sleep loss and jet-
lag

A record can be tagged to any numb

Title Assessing sleep, travelling habits and jet lag in kite surfers according to competition level
Source Biol.Rhythm Res. 2016, 47, 5 677-689
Folders |etlag;Last imported,

ReflD 2796

Journal Aricle Reference 4 of 4

Authors Thun E.; Bjorvatn B ; Flo.E.; Harris A ; Pallesen.S.
Title Sleep, circadian rhythms, and athletic performance
Source Sleep Medicine Reviews, 2015, 23, 1-9
Folders jetlag;Lastimported,

Support Center

Webinars
fYE]

Folders =]
ebiwari (1) -

ebiwari test (1)
fishy (11)
friday test (1)

green economy  (4)

medline testv2 (8)

nanking (4)

Quick Access 5}
i, Advanced Search
I Import

Il Export

IE Create Bibliography

LEI'J Print References

@ Completed

4 item(s) moved to jet lag.




To add references for books from UoA

use the Search feature in RefWorks

@® RefWorks
s v [

»Advanced

5 Crea
» By Author

o MNew Folder

By Descriptor

References > All Refe

Language |

Update Profle | Customize | Contact Us | Refilobile | Log out

University of Aberdeen

Welcome, ewanag.

Search Your Database |J:, . Search
y . |
“ference Additional Information Announcements 0
Resources I

References Folders | 123459
References to IBJRSS Feeds B Sort by Change View
3 1_h - -
® Selected Page All'in List | < = kall=" Authors, Primary - Standard View v
RefID 2052 Journal Article Reference 1 of 2268 (3 5] X
Title  Straight talk.
Source Radiol Technol , 2014, 85, 5, 592
Folders hemingway test;medline test v2;
RefID 1563 Journal Article Reference 2 of 2268 b 4
0 0

Support Center
Webinars

Folders I
Ny List
Mot In Folder  (33)
)
aberdeen fish (29)

8

g Last Imported (

accounting (19)

archaeology (44)

|

Select Online Catalog or Database




Select Advanced Search option and enter Title and Author

details
u Online Cataleg or Database
' Search Online Catalog or Database o Help
Request a 739.50 Site

Search: University of Aberdeen

nces to Download: 50

Field: Title, Primary

Field: Authors, Primary

In this example we are looking for: Foster, Sally M (2014) Picts, Gaels and Scots: early

historic Scotland. Edinburgh: Birlinn

Then select Search at bottom of screen




Be sure to select the correct edition

and then select Import at bottom of screen

Online Catalog or Database

Search Results for Advanced Search University of Aberdeen

Total references found: 3

References to Use (Mote that references are also put in the Last Imported folder)
® selected Page Allin List T 3 Sort by v
RefID 1 Book, Whaole Reference 1 of 3 3
Authors Foster Sally M. ; Histaric Scotland
Book Title Picts, Gaels, and Scots: early historic Scotland
Source 1996, 128, B. T. Batsford. London
ReflD 2 Book, Whole Reference 2 of 3 3
Authors Iy M.; Historic Scotland
Book Title |z and Scots: early historic Scotland
Source Batsford, London
7 RefID 3 Book, Whaole Reference 3 of 3 o]

Authors  Foster.Sally M
Book Title Picts, Gaels and Scots: early historic Scotland
Source 2014, 184, Birlinn, Edinburgh, MNew

+) Mew Search | Import




The Import screen is presented

gl LAl IR SUILS T SivVallEll Sl L]

VT SILY U S S LSS

Import Results X

Import Log
Import Date 11/22/2015 1:20:52 PM

Vendor University of Aberdeen

Duplicate Checking Options

Select View Last Imported Folder

to complete the addition of the reference

L | View Duplicates View Last Imported Folder |
d
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Removing duplicates,
adding notes and attachments
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Some other RefWorks features “PABERDEEN

It is also possible to:

* Remove duplicates — very important

* Add attachments to any reference — useful if you have a full-
text copy of the record

e Each attachment must be less than 20MB

* Add notes to any reference



Creating Subfolders

University of Aberdeen
@ R e f WO r k S Welcome, Elaine&Janet&Susan .

Search your RefiWorks database ﬁ -4 Search
|I_.;g| New Folder | Create Bibliography | @ New Reference | Additional Information Resources =
) ) J O
E Support Center

References > Close Duplicates p | \Vebinars
- 60

References Eolders -

You have 13 reference(s) not in foldS =w Shared Ares ﬂi Statistics |3 Default Settings -

chapter1 (2)

Share Entire Database (364) Iﬂ chapter2 ()

Mot In Folder (19)

chapter3 (0)

@ Lastimpored (6) = chapter4 (0) F
acid rain (82) = Conference Proceedings

= G electronic books  (4)

|'__I ietlan, WK6)
ICreate Subfolder

chapter1 (2)

@ Clear Folder plogy (30)
chapter2 (0} Ix Delete Folder 2
chapter 3 (0} (L Find Duplicates Place .

Open Organize & Share Folders tab
Find main folder

Click on the Folder icon to open the drop-down menu
Select Create Subfolder




Creating Subfolders

Language | Update Profile | Customize | Contact Us | Refidobile | Log out

® RefWorks elcame, ElinbaneisSusan

Search your RefiWorks database ﬂ -4 Search

Additional Information /_I

|I_;;g| Mew Folder . | Create Bibliography . | @ Mew Reference . Resources a
J J . E Support Center
References > Close Duplicates » Webinars
References || Organize & Share Folders | Folders .

You have 12 referencefs) not in folders. Duplicates not in folders. % View Shared Area ﬂi Statistics |3 Default Settings

chapter 1 (2)

Share Entire Database  (364) Create New Folder chapter2 (0)

Select a Parent Folder: Mew Folder Name:

Mot In Folder (19) chapter 3 (0)

body image b media

[@ Lastimported (6) yimag chapter4 (0) B
acidrain (82) Conference Proceedings
anchorages (260) \ ) electronic books  (4) =

; g Create Clncel 1
bodyimage (64) . jetlag (66)
%

Cardiovascular Disease (8) = paper - nature  (82)
chapter 1 (2) = & Psychology (50) |
chapter2 (0) = 3 -
chapter3 (0 .
chapter3 (0) =i Quick Access -

chapter4 (0) 5

 Name the subfolder

* Click on Create button




Creating Subfolders

Language | Update Profile | Customize | Contact Us | RefMobile | Log out

@® RefWorks i

Search your RefWorks database ﬁ -4 Search
|_¢y New Folder . Create Bibliography | (& Mew Reference . Additional Information ¢ Resources a
- | | (9]
E Support Center
References = Close Duplicates » febinars
- 606
References ] | Organize & Share Folders | Folders a
ou have 13 reference(s) not in folders. Duplicates not in folders. & View Shared Ares Eiil Statistics |3 Default Settings -
chapter1 (2)
Share Entire Database (364) Iﬂ chapter2 (0)
Mot In Folder (19) chapter3 (0)
@ Lastimported (8) = chapter 4 (0) ¥
acidrain (82) = Conference Proceedings
= electronic books  (4) =
= bodyimage (64) = jetlag (GB)
media (0} = paper - nature  (82)
= Psychology (50)
chapter1 (2) = G -
chapter2 (0 [ .
thapter2 (0) e Quick Access =
chapter3 (0) =
4, Advanced Search
rhantard My = E=

« Subfolders = listed under the parent folder (indented)




Managing your records — remove duplicate records

University of Aberdeen
® RefWorks Weicome, owanag
Search Your Database |d§- » Search
e Additional Information |
& Mew Folder shy | | @ New Reference E— Announcements
All References 0
=]
- & Resources g
References ' B L
Duplicates Support Center
Webinars
N % Deleted Reference
Referen ) L 1]
References to Use by Change View
Selected Page ®) Allin List S| Authors, Primary Standard View v FILE -
ebiwari (1) -
ReflD 2795 Journal Article Reference 1 of 4 Sk X X ebiwaritest (1)
Authors FullagarH H.K.; Duffield.R.; Skorski.S.; White.D.; Bloomfield.J.; Kélling.S.; Meyer.T. fishy (11)
Title Sleep, travel, and recovery responses of national footballers during and after long-haul international air B i
travel friday test (1)
Source |nternational Journal of Sports Physiology and Performance, 2016, 11, 1, 86-95 areen economy (4)
Folders |etlag;lastimported; R Co
- — hemingway test (4
ReflD 2794 Journal Article Reference 2 of 4 I g[s 4 L
jetlag (4
Authors HKolling S Ferrauti. A ; PeifferM.; MeyerT.; Kellmann. M.
Title Sleepin sports: A short summary of alterations in sleep/wake patterns and the effects of sleep loss and jet- language lab (2)
lag - 5 o
Source Deutsche Feitschrift fur Sportmedizin, 2016, 67, 2, 35-38 mediine testv2 (8)
Folders |etlag;Last Imported; nanking (4)

Do this on a regular basis

Never delete records that you know you have already cited in your work — only the
more recent duplicate (check the RefWorks ID number)




RefWorks selects the newest record to remove (higher

reference ID number) because you are more likely to have
used the first record

| Search your RefiVorks database &5 4 Search
. Additional Information \
o Mew Folder Create Bibliography &h New Reference | Resources a
E Support Center
o akin L=
References > Close Duplicates p | Trevinars
| 1)
References | | Organize & Share Folders | 12 Mext Last Folders a
References to Use Saort by Change View DG e ase
Selected Page i @ Allin List °7 Duplicate |+]  Standard View [~ chapter 1 (2)
chapter2 (0)
Magazine Article Reference 1 of 30 &1 X )
chapter 2 (0)
U uoers, A -

Title BACK TO SCHOOL: Harry Potter and the Order of the Phoenix is just the latest entry in a tradition of British chapter4 (0)
boarding-school movies that stretches back to the 1930s. Butthe public-school ethos also spawned a Conference Proceedings
slew of post-war films about men who refuse to grow up TR TR

Source SIGHT AMD SOUMND, 2007, 17, 8, 46, BRITISH FILM INSTITUTE electronic books  (4) L
Folders Psycholoay; r
jetlag (B6)
ReflD 312 Magazine Article Reference 2 of 30 AL, .
paper - nature (82)
Authors Roberts Andrew L .
Title Back to school Psychology (50
Source Sight & Sound, 2007, 17, 8, 46-49, Britizh Film Institute, London =
: Quick Access =]
Journal Article Reference 3 of 30 Okl X )
Authors DrustB.; Waterhouse ) Atkinson.G.; Edwards,B. Reilly.T. , Advanced Search
Title Circadian rhythms in sporis performance - An update - Import
Source Chronobiollnt, 2005, 22, 1, 21-44 d o
- Export
ReflD 19 Journal Article Reference 4 of 30 g7 X | L |
Authors Drust B ; Waterhouse J; Atkinson, G, Edwards B Reilly, T. @ Create Bibliography
Title Circadian rhythms in sports performance - An update 3 Delete References
Source ChronobiolInt, 2005, 22 1, 21-44
Folders anchorages;jetlaq; bEg Print References




g (NVERSITY OF

| have lots of full text electronic copies of references =y AgrrRDEEN

I’'ve read — can | store them in RefWorks?

e Yes—individual document size limited to 20MB

e Default storage capacity is 100MB but this can be increased (no-
one to date has needed the full storage allowance)

 Open full record in RefWorks web account (via Edit) or create
new record

* click on Browse to find file
* click on Add Attachment to upload

e Open attachment from full record view



References = [jet lag

References | Organize & Share Folders |
References to Use B Sort by Change View
@ Selected | O Page | O arinLst § |© 7 © X a Authors, Primary ¥ | Standard View v

2] ReflD 2793 Journal Article Reference 1 of 4 LAY ¥ {}4

Authors FullagarH.H.K.; Duffield.R.; Skorski.S.; White.D.; Bloomfield.J.; Kdlling.5.; Meyer.T.

Title Sleep, travel, and recovery responses of national foothallers during and after long-haul infg | air
travel
Source International Journal of Sports Physiology and Performance, 2016, 11, 1, 86-95
Folders |eilaqg;
O RefID 2794 Journal Article Reference 2 of 4 k& X {14 ¢

Authors Kolling.S. Ferrauti,A.; Pleiffer .. Meyer.T.; Kellmann.M.
Title Sleep in sports: A short summary of alterations in sleep/wake patterns and the effects of sleep loss and jet-

lag
Source Deutsche Zeitschrift fur Sportmedizin, 2016, 67, 2, 35-38

Folders |eilaqg;

O ReflD 2793 Journal Article Reference 3 of 4 (RO g[A X (1] ¢

Authors Silva.M.-E.G.; Pascoal A Silva.H-H.; Paiva.T.
Title Assessing sleep, fravelling habits and jet lag in Kite surfers according to competition level
Source Biol.Ehythm Ees., 2016, 47, 5, 677-689
Folders |eilaqg;




Edit Reference

ReflD: 2795 & Help “
Fields used by [Harvard v | @ About this style
and Reference Type | Journal Article v
g Mew R
— The following fields are used by your selected output style. You can access additional fields below.
=
Referend Authors: FullagarH.H K. ;Duffield R Skorski, 5. White, D Bloomfield,J ;Kalling, 5., Meyer T ;
Tile: g 7 g x x|
R Sleep, travel, and recovery responses of national foothallers during and after long-haul
international air travel
® Sezlecy -
| |
Periodical, Full: International Journal of Sports Physiology and Performance
Pub Year: 2016
Volume: 11
o Issue:/1
Start Page: 86
Other Pages: 95
Add to folder Select a folder.. b -
(|
=]
Attachments Choose file | Mo file chosen
B AAAt AnAl Ciolde -
1 3
(|
= Mext [ Duplicate | | [=] Save Reference | | (&) Save & Add New

m j:ll.l::-l::IJ WEUILIE MEVIEWS, ZUTJ, 23, T-3 | d:h Print Eeferences




g MewH

Referend

%) Select

Edit Reference
I he tollowing nelds are used by your selected output style. You can access addiional nelds below.

Authors: FullagarH H_K_;Duffield R Skorski 5. ;White, D _;Bloomfield, J ;Kdlling,S.;Meyer T ;

Tie: § 7 U x x|

Sleep, travel, and recovery responses of national foothallers during and after long-haul
international air travel

Periodical, Full: International Journal of Sports Physiology and Performance
Pub Year: 2016
WVolume: 11
Issue:|1
Start Page: |36

Other Pages: 95

Add to folder Select a folder... v

jetlag =1

Attachments Choose file | Mo file chosen

= Next L) Duplicate | | [=] Save Reference = J) Save & Add New

4

SUUTLE STEEL WELUTLTE MEVIEWS, ZUTd, 23, T-3F

= Frint Eeferences




Records with files attached display a paper clip icon

® HetWorks

Search chronohiological

Additional Information

o Mew Folder |E Create Bibliography w3 Mew Reference

References > [ jjetlag

References | Organize & Share Folders
Referances to Use _ Sort by Change View
® Selected Page Allin List s * @ X258 [Authors. Primary ¥ | | Standard View v
RefID 2795 Joumnal Article Reference 1 of 4 >d L % {1 &

Authors FullagarH.H.E.; Duffield.R.; Skorski.S.; White.D.; Bloomfield..; Kélling.S.; MeyerT.
Title Sleep, travel, and recovery responses of national foothallers during and after long-haul international air
fravel
Source International Journal of Sports Physiology and Pedformance, 2016, 11, 1, 86-95
Folders [eflag;

RefID 2794 Journal Article Reference 2 of 4 (3 €3 k[ X

Authors Killing.S.; Ferrauti.A.; PieifferM.; MeyerT.; Kellmann.M.
Title Sleepin sports: & short summary of alterations in sleepfwake patterns and the effects of sleep loss and jet-
lag
Source Deutsche feitschrift fur Sportmedizin, 2016, 67, 2, 35-38
Folders |etlaq;

RefID 2793 Journal Article Reference 3 of 4 €Ik [s7 X

Authors  SilvaM-BE.G; Pascoal A Silva.H-H_; Paiva,T.
Title Assessing sleep, travelling habits and jet lag in kite surfers according to competition level
Source Eiol.Ehythm Ees., 2016, 47, 5, G77-689
Folders |eilag;




RefWorks Web Based Bibliographic Management...

Making notes

a

0

]

O

TOTOC T

RefID

Article Title
Source
Folders

RefID
Title

Source
Folders

RefID
Title

Source
Folders

RefID
Article Title

Source
Folders

A8 % =i ea ) g e

3810 Mewspaper Article Reference 2 of 20 4
Farthe love of art and good causes

The Business Times, 2012, nfa, Singapore, United Kingdom, Singapore

Art & Business;

3817 Journal Article Reference 3 of 20 4

o

Banking, Financial Services; Bank of America Announces Unique Art Conservation Project

Investment Weekly Mews, 2011, 230, NewsRx, Atlanta, United States, Atlanta
Art & Business;
3818 Report Reference 4 of 20 iE 4

Turkiye Halk Bankasi A.S. Halkbank - Annual Report, 2011
Reportal, 2011, nfa, REPORTAL. SDN. BHD., Kuching, Malaysia, Kuching
Art & Business;

3823 Mewspaper Article Reference 5 of 20 ®

o

]

RefID

0

a

Book Title

Folders
ReflD
Authors
Title

Source
Folders

RefID

Authors
Article Title

Source
Folders

oo

Lehman’s Last Sale

Wall Street Journal (Cnline), 2010, nfa, New York, N.Y., United States, New York, M.Y.

3826 Book, Whole Reference 6 of 20 5
ulture Works : The Political Economy of Culture

Art & Business;

3813 Journal Article Reference 7 of 20 4

Barhat Yikram
BEAUTIFY YOUR CLIENT'S PORTFOLIO

Advisor's Ede

e, 2011, 20, Rogers Publishing Limited, Toronto, Canada, Toronto
Art & Business;
3578 Mewspaper Article Reference 8 of 20 JE 4
Barr, Damian

Mira, Mirc on the wall who's the richest of them all? As businesses vie with each other to buy the best
works of art, Damian Barr tours London's newly booming carporate collections, while Anna Metcalfe
discovers the pieces that inspire top executives

Financial Times, 2007, 20, London (UK), United Kingdom, London (LK)

Art & Business;

Aararc | o Al le P\ _feem o m _LAR

-
.'

W 950

Announcements

Resources
Support Center

Webinars

Folders
r My List
MNotin Folder ({63)
@ Lastimported (6)
Art & Businezs (20)
Business Schoaol (1)
Coaching Culture (7)
» Documents  (0)
Finance (5)
Katie Stearman (4)

Leadership (1)

Quick Access

-, Advanced Search

i Import

J Export

[ Create Bibliography

(&) Print References

Statistics

188 Reference(s)
21 Folder(s)

o -



RefWorks Web Based Bibliographic Management...

Making notes

TOTOCT T =3 £ g

Art

Art

Bi

Edit Reference
ReflD: 3826

Fields used by |Hamvard El @ About this style

and Reference Type Book, Whale [~
The following fields are used by your selected output style. You can access additional fields below.
Authors:

Book Title: B 7 UX x

Culture Works : The Political Economy of Culture

m

Pub Year:2001
Edition:
Publisher: University of Minnesota Press
Place of Publication: Minneapolis, MN, USA
Add to folder Select afolder... >

Art & Business [g

Aftachments

Browse...

» Additional Fields

= Prev =» Next

[[7 Duplicate | [=] Save Reference | (&) Save & Add New

4
alFolder(s)

m




Making notes

RefWorks Web Based Bibliographic Management... -
Edit Reference X
Art Retrieved Date: -

Shortened Title: g 7 gy x,

Usert: g s b x,

m

Ebrary e-book

Art
Userz g 5 gy % x°
Bi
User3 g 5 U x, x°
Art s
&= Prev | |=» Next [ Duplicatl | [=] Save Reference = | ([l Save & AddNew = &

4

older(s)

nocn Aarar T —— e T




Previewing styles and
adding styles to a favourites list
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Choosing your favourite citation styles

Before looking at WNC 4 make sure the referencing style you
need to use is in your Favourites list

On your main RefWorks account:

* From the Bibliography menu you can choose the citation styles you
are most likely to use and keep them as your favourites

* Ask your supervisor/course co-ordinator or refer to your course
handbook if you are unsure of which citation style to use



Preview Output Style allows you to see

what a particular style looks like...

Contact Us | RefMobile | Log out

® RefWorks

University of Aberdeen

Welcome, Elaine&Janet&Susan .

Bibliography Search your RefWorks database |u’; » Search
Addition nfa ion
o Mew Folder Create Bibliographv ilchtional knformeion Resources a
~0utput Style Manager 0
2 Support Center
&
References > All References p | eninans
mi
References | | Organize & Share Folders | Follers -
References to Use _ Soriby EEEAUEY My List -
v |5 X . . vy LIS
9 selected ) Page i () Allin List dv |BIX2 Authars, Primary |Z| Standard View E| —
MotIn Folder (19)
|:| RefID 291 Mewspaper Article Reference 1 of 364 AE b4 L 3 Lastimported () |
Article Title  University offers new psychology course for graduates acidrain  (82) B
Source (GreatBarr Observer, 2011, 5 .
Folders Psychology anchorages (260)
i v » body image )
m ReflD 257 Journal Article Reference 2 of 364 Ok X , yimage (64)
Title World review: Asia & Pacific Rim: Bangladesh: The Bangladesh government... Cardiovascular Disease
Source Hydrocarbon Engineering, 2010, 15, 5, 104 ~hante 3
chapter1 (2)
Folders anchorages;
chapter2 (0)
W RefID 260 Journal Article Reference 3 of 364 Gkl X L
chapter3 (0) il
Title Mews: Alaskan pollution conspirators brought to book
Source MarFollutBull., 2002, 44, 10, 980-881 B - =
Folders anchorages;
W RefID 332 Web Page Reference 4 of 364 5[ X X , Advanced Search
Title esrc capabilityandresilience [ !mpor
Source 2011, 7TH8/2011, hitpwowew.ucl. ac.ukicapabilityandresiliencel Export
Folders Psycholoay; § Expo
| = ReflD 324 Monograph Reference 5 of 364 = [ o 1 g Create Bibliography




Lanquage Update Profile Customize | Contact Us | Refld

University of Aberdeen
Q RBfWOI’kS Welcome, Elaine&lanet&Susan .

Search your RefiVorks database - Search

Preview Output Style

Select a style and type of citation to preview.

Output Style  Vancouver - Use references in my database

m

Book, Edited

Bibliography
(1) Ferrari JR, Johnson J, McCown WG, Smith J editors. Procrastination and task avoidance: theory, research, and treatment. Mew York: Plenum Press;
1895,

In-Text Citation (1,3-6)

Book, Section

Bibliography
[ (1) Dods JB. Lecture |. Electrical psychology—lis definition, and importance in curing diseases. In: Dods JB, editor. The philosophy of electrical psychology in
a course of twelve lectures. Mew York, NY US: Fowler and Wells Co Publishers; 1850. p. 15-32.

In-Text Citation (1,3-6)
Book, Whole

Bibliograph
(1) Ricord E. glements of the philosophy of mind, applied to the development of thought and feeling. NMew York, MY US: John M Bogert; 1840.

In-Text Citation (1,3-6)
F Conference Proceedings
Bibliography
(1) Gernsbacher M&, Derry SJ, editors. In defense of logical minds. Proceedings of the Twentieth Annual Conference of the Cognitive Science Society; Aug
01-04 2008; Mahwah, N.J.: Lawrence Erlbaum Associates Inc. Publishers; 18998,
In-Text Citation (1,3-6)
Dissertation/Thesis
Bibliography .
(1) 5ue Ann Grey. Vincentvan Gogh, a formal and psychological analysis of the final years at Arles, Saint-Rémy, and Auvers. US: ProCuest Information &
Learning; 2011.
[ In-Text Citation (1,3-6)

FRiceartatinn/Thaceie llnnnklichad r/,”/;

Danlk Titla Docasrch clhille fAar chhiAante Y T P 1




Language Update Profile | Customize | Contact Us | RefMobile | Log out

University of Aberdeen
Q R&fworks Welcome, Elaine&Janet&Susan .

Search your RefWorks database & - Search

(=
Ly
@Help [
Refi
Output Style = [ Use references in my database
Book, Edited 3
@ .
Bibliography
Ferrari, J.R., Johnson, J., McCown, W.G. & Smith, J. (eds) 1995, Procrastination and task avoidance: theory, research, and treatment, Plenum Press, New
Yark.
E
In-Text Citation (Ferrari et al. 1995) B
Book, Section
Biblio raphg
E Dods, JB. 1850, "Lecture . Electrical psychology—Its definition, and importance in curing diseases™in The philosophy of electrical psychology in a course of
twelve lectures., ed. J.B. Dods, Fowler and Wells Co Publishers, New York, NY U3, pp. 15-32.
In-Text Citation (Dods 1850)
Book, Whole
C .
BI|J|IUgErth
Ricord, E. 1840, Elerments of the philosophy of mind, applied to the development of thought and feeling, John M Bogert, New York, WY LS.
In-Text Citation (Ricord 1840)
F Conference Proceedings
Bibliography
Bringsjord, ., Moel, R. & Bringsjord, E. 1998, "In defense of logical minds®, Froceedings of the Twentieth Annual Conference of the Cognitive Science
Society, eds. MA Gernsbacher & 5.J. Derry, Lawrence Erlbaum Associates Inc. Publishers, Mahwah, MN.J., Aug 01-04 2008, pp. 178.
E In-Text Citation (Bringsjord, Mol & Bringsjord 1998)
Dissertation/Thesis
Bihlir:ugragjhy .
Grey, 8.A. 2011, Vincent van Gogh, a formal and psychological analysis of the final years at Arles, Saint-Remy, and Auvers, ProQuest Information &
Learning.
[ In-Text Citation (Grey2011)
FMiceartatinn/Thacie Inmihlichad '/2

Dl Tl | s [ WA U I [P R S [ 1 s 4 a- 1




To store your favourite citation styles open the Bibliography

menu and select Output Style Manager

® RefWorks

University of Aberdeen
Welcome, Elaine&Janet&Susan .

. Bibliography Search your ReflWorks database |-=@ » Search
Additional Info ion
o Mew Folder Create Bibliograghv Additional Information Resources a
¥ ut Style Manager O
2  Suppor Center
= o
References > All References 7
s Preview Qutput Style [ 1]
References | Organize & Share Folders | Folders .
ST s - Sort by Change View g
v || M . . My List
9 Selected ) Page i (D) Allin List 47 @\ X|& Authors, Primary E| Standard View E —
Mot In Folder (19)
[ ReflD 291 MNewspaper Article Reference 1 of 364 AE b4 L 3 Lastimported () |
Article Title  University offers new psychology course for graduates acidrain  (82) I
Source Great Bar Observer, 2011, 5
Folders Psycholoagy; anchorages (260)
A ReflD 257 Journal Article Reference 2 of 364 Q[ X L » bodyimage (64)
Title World review: Asia & Pacific Rim: Bangladesh: The Bangladesh government... Cardiovascular Disease
Source Hydrocarbon Engineering, 2010, 15, 5, 104 chapter 1 (2)
Folders anchorages, :
! chapter2 (0)
H ReflD 260 Journal Article Reference 3 of 364 Okl X L paer s (O
chapter 3 (0) 1
Title Mews: Alaskan pollution conspirators brought to book
Source I.1_ar._F'_u:uIIL|t;EF|II..2002.44.10.980—981 Quick Access S
Folders anchorages;
H RefID 332 Web Page Reference 4 of 364 AER . ! , Advanced Search
Title esrc capabilityandresilience I !mport
Source 2011, 7182011, http:/iwww.ucl.ac.ukicapabilityandresilience/ Export
Folders Psvchology; 4 Expo
v Create Bibliography
H RefID 324 Monograph Reference 5 of 364 5[ X ! et grapny
— = = 3 Delete References




Output Style Manager — Select style from List of Output Styles,

Click on green arrow to add to Favorites

® RefWorks

University of Aberdeen
Welcome, Elaine&Janet&Susan .

Search your RefWorks database u,: L Search

SRLE  Output Stvle Manaaer X

i
"

@

vl

< Search

—] Show All -

List of Qutput Styles

@ 5el

AAAR - Arctic, Antarctic, and Alpine Research

Arl | AACC - American Association of Cereal Chemists

AAPG - American Association of Petroleum Geologists
AAPS - American Association of Pharmaceutical Scientists

ity: Business School
Aberdeen University: MSc Project Management

(Harvard)
Aberdeen University; TESTING - OSCOLA (2009)
Aberdeen University: TESTING - Quality, Exposure and Health =

Council of Science Editors - CSE Tth, Citation-Sequence
Council of Science Editors - CSE Tth, Name-Year Sequence
Harvard

€

Your favorite output styles are what you can easily access when working
in RefWorks and Write-MN-Cite.

Favorites

APA 5th - American Psychological Association, 5th Edition
APA Bth - American Psychological Association, 6th Edition
Chicagoe 15th Edition (Author-Date System)

Harvard - British Standard

MLA Tth Edition

Unifarm - Uniform Reguirements for Manuscripts Submitted to Bi
Vancouver

Preview Output Style ¥ Remove All
A
ReflD 324 Monograph Reference 5 of 324 e X
Authors Aboud.Frances E.

Title Health psycholoav in alobal perspective
Source 1998, 2, 329 Sage Publications, Thousand Oaks




Favorites — can remove styles you don’t need from your

Favorites list by using the lower green arrow

University of Aberdeen
. Ref Works Welcome, Elaifl-'.;&..lanet&&‘.uaan &

Search your RefWorks database g:. L Search
SE  Output Stvle Manager X
& Help
Referg -4 Search
Your favorite output styles are what you can easily access when working
in RefWorks and Write-N-Cite.
— Show All -
| H
List of Qutput Styles Favorites
@) el
AAAR - Arctic, Antarctic, and Alpine Research - Aberdeen University: Business School -
Arl | AACC - American Assaciation of Cereal Chemists £ APA 5th - American Psychological Association, 5th Editi
AAPG - American Association of Petraleum Geologists APA Bth - American Psychological Association, bth Editi
AAPS - American Association of Pharmaceutical Scientists Chicago 15th Edition (Author-Date System)
Abdominal Imaging = = — — -
Aberdeen University: MSc Project Management (Harvard) | Council of Science Editors - CSE Tth, Name-Year Seque
Aberdeen University: TESTING - Geological Society of London
Aberdeen University: TESTING - OSCOLA (2009)
Aberdeen University: TESTING - Quality, Exposure and Health MLA Tth Edition
Aberdeen University: TESTINGZ - Plant & Soil Science (Harvard ¢ = Uniform - Uniform Requirements for Manuscripts Submitte =
FPreview QOutput Style ¥ Remove All
P
ReflD 324 Monograph Reference 5 of 324 AE X
Authors Aboud.Frances E.

Title Health psychology in alobal perspective
Source 1998, 2, 329, Sage Publications, Thousand Oaks




Favorites — your favourite citation styles can then be seen in the Output Style
drop-down list when you go to the Bibliography menu and select Create

University of Aberdeen
. Refworks Welcome, Elai?:re&._lanet&s.uaan .

| Search your RefWorks database

» Search

List of Qutput Styles Reguest Mew Qutput Style

e Harrard - Britich andard ||
e
Aberdeen University: Business S
ikl . APA &th - American Psychologid
Format Paper and Bibliography ¥
P Py APA Bth - American Psychologia
Chicago 15th Edition (Author-Dat
Council of Science Editors - CSE
Council of Science Editors - CSH
Harvard
File Typi Hamvard - British Standard a
MLA 7Tth Edition
D t F ts 3 rh I
CEUmEnt FRmSEs SUPPOTE ) niform - Uniform Requirements '
ences toInclud{  Vancouver
University of Aberdeen Specific
APA 5th - American Psychologig

Format a Bibliography frgm a List of Rg
Ar

Refe ks

Harvard - British Standard
Vancouver

!

Create Bibliography
P

Folders Psychology

RefID 324 Monograph Reference 5 of 324




Practical Session

NIVERSITY OF
BERDEEN

Please follow the Steps 1 and 2 in worksheet Managing References — RefWorks Part 2.

* Step 1: Previewing styles

* Step 2: Compiling a favourites list of citation styles

Managing References: RefWorks Part 2

Information Skills Practical Workshop

end of your document.

In this workshop you will be using your web-based Ref\Works account in conjunction with Microsoft Word and a utility
called Write-N-Cite to insert citations within a document (in-text citations) and create a reference list/bibliography at the

PLEASE ASK FOR HELP IF YOU ARE UNSURE WHAT TO DO. WE ARE HERE TO HELP YOU!

After the 2 steps above we will all “write a thesis” together
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Issues with Footnote styles
* Footnote styles can be too complex to create within WNC
 Examples: Chicago versions 15 and 16, Turabian and MHRA

* Need to tweak the formatting generated by WNC so as to include
background reading material in Bibliography...

* and notes and citations in footnotes...
* and produce separate lists for primary and secondary sources
* Recommendations:
e Often easier to produce the bibliography manually
 However, use RefWorks as a virtual filing cabinet



Now ...

UNIVERSITY OF Managing References — RefWorks Part 1
ABERDEEN ging

Information Skills Practical Workshop

RefWorks is a web-based bibliographic management software package that allows you to store and manage your
references, and to create correctly assignments and bibliographies.

IMPORTANT: RefWorks introduced a new version in autumn 2016 which is referred to as ‘New RefWorks’.
However, at the University of Aberdeen we will continue to use and support the previous version — ‘Legacy
RefWorks’ — until summer 2019. At that point we plan to upgrade to and provide support for the New RefWorks
version.

Managing References: RefWorks Part 2

Information Skills Practical Workshop

This worksheet is designed to take you through the basics of using RefWorks and will cover the following:

In this workshop you will be using your web-based Ref\}/orks account in conjunction with Microsoft Word and a utility
called Write-N-Cite to insert citations within a document (in-text citations) and create a reference list/bibliography at the
end of your document |

Write-N-Cite (WNC) is an app or uility or plug-in which allows Microsoft Word to connect to your web based Bef\Works
account. WNC is already installed on university networked PCs - instructions on installing WNC to a personal machine is
provided in the appendices to this worksheet.

RefWorks introduced a new interface in Autumn 2016 and refer to this version as “new RefWorks”. However,

at the University of Aberdeen we will continue to use and support the previous version — “legacy RefWorks” -
until summer 2017. At that point we will upgrade to, and provide support for, the new RefWorks’ interface.”

STEP 1: Register for a RefWorks account p.1 | STEP 6: Create a new reference manually p.3
STEP 2: Create a folder to organise references p.1 | STEP 7: Edit a reference in your account p-3
STEP 3: Importance of planning your searches p.1 | STEP 8: Remove duplicate references p.3

STEP 9: Create a standalone bibliography p-4
STEFP 5: Import references from other databases . STEP 10: Help and advice p-4

Step Page
1 — Previewing styles 5 — Editing a specific reference in RefiWorks 4
2 - Compiling a favourites list of citation styles 6 — Help and advice 4
3 — Adding attachments to References Appendix 1 - 5
in your RefiWorks account Installing Write-N-Cite v.4 on Microsoft machines
4 - Using Write-N-Cite Appendix 2 - 6
Installing Write-N-Cite v.4 on Mac machines

Try some extra steps as demonstrated - worksheets for Part 1 and Part 2

Obijective: several folders, a minimum of 10-12 records in your account,

none of these duplicated...




Using Write-N-Cite (WNC) -

live demonstration

3 N



What is Write-N-Cite (WNC v.4)?

™ UNIVERSITY OF
P ABERDEEN

* WNCis a plugin for Microsoft Word which allows you to insert citations
you have saved in RefWorks directly into the text as you write

 Formats in-text citations automatically and creates a bibliography at the
end of the document in a chosen citation style

 Opened from a tab in Microsoft Word application

* Already instal
* You may heec

* You can instal
Worksheet

ed on classroom PCs
to install to your office PC (from the Software Center)

to your personal PC/Mac (from RefWorks). See Part 2
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HOME INSERT DESIGN PAGE LAYO it MAILINGS REVIEW VIEW ACROBAT m Grant, Ewan A, ~
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Citation and Bibliography Extras Settings ~
1 4 1 2 3 4 5 6 7 g s 10 11 12 13 14 5. R 17 18

After W-N-C 4 is installed you must sync with your RefWorks account to download your
references, folders and preferred reference styles:

1. Click on in the ProQuest tab within Microsoft Word

2. It may take a few minutes to sync with your RefWorks account




Be sure that RefWorks is selected at the top.
Then enter your username and password. DO NOT USE the “login from my
institution” option — does not work at University of Aberdeen.

Insert Design Layout Reference Mailings Revi Vi Mathemati RefWorks @ Tell me what you want to do... Sign in R_ Share

Log in with RefWorks

If you are off campus you may also be asked for the Group Code. You received the code
in the email you received when you first set up your RefWorks account




This pop-up shall appear, informing you that there is a
later version of W-N-C available. Click OK to ignore this.

ut References Mailings Review View Mathematics RefWorks

ase login into your Refinorks .com account and download the new

0K

RefWorks released an update in October. Waiting to add to Classroom PCs next term
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Home Insert PHE ol Retelienee Mailings Review View Developer Add-Ins RefWorks
==t| 4 Style: AMA - Ame.. & Log Out

@' Preferences
Enable AutoSync Folder

Settings

@,Bihli-ﬂgraphyomians
Insert
Citation = .@ Reapply Cutput Style
Citation and Bibliography

| 4 -1 5 -1 f- 1+ F -1 -8B 1 -5 @I 1 -41: 1 121 13- 1 141 15 1 A e T iF 1 - 18 -
g g g g g g g g T g

(L5l

Where it previously said ProQuest at the
g top of the screen it now says RefWorks

{_o Click on Sync My Database after you make changes to your main RefWorks
E account, e.g. edit references or add new references or folders

113

Page:1 of1 | Words: 0 | 5 | [Hleg® = = 125% (o) » {t)



| D e s BT

Ra e Layout References Mailings Review View Developer Add-Ins RefWorks

= g Style: Recent Styles [@S}-‘ncr‘ﬂy Database Pe Log Qut

Y, Bibliography Options 5 Remove Field Codes & Preferences S I t th I t f [ t I
Citation ~ -' Reapply Output Style Open RefWorks Enable AutoSync Folder e ec e re evan re erenCIng S y e

Citation and Bibliography Extras Settings
2 v 10 -% L 1 3 1-3 1 -4:1 -5 -1 61 -7 0 8B:1-9 01 4L 131 131 14 -1 15- 1 Ao iegge i ogg | E_EJ
= T T T T T T 7 7 7 T T T
F
o F . |
05 Select Output Style E3

Select a Filter From the Dropdown

z Filter: | My Favorites -

Maote: Maore styles are available in Refworks via the Output Style Manager.

= MHRA-Madem Humanities Research Association (Motes & Biblingraphy) -
- Harvard 1y way
- Historische zetschrift
: Chicago 15th Edition (Motes & Bibliography)
< Aberdeen University: TESTING - QSCOLA (200G)
Harvard - British Standard
MHRA-Comect
MHRA Elaine’sversion
Bl -Society of Biblical Literature (Author-Date)
Ol =i

m

glo-
Systemmatic Review Style
SBL-Society of Biblical Literature (Notes-Bibliography) &

@ Save ancel

If the style you need isn’t listed in the popular styles, favorites or group favourites options in the Filter menu:
1. Log in to your main RefWorks account and add it to your Favorites list using the Output Style Manager
2. Thenin WNC Sync My Database to download the new style

Page:1 of1 | Words: 0 | <35 | |[Blemz = 125% (=) [}

I+l o »
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Insert

Review View Add-Ins Ref\Warks

Page Layout References Mailings Developer

style:  Harvard - L_@ Sync My Database :, Log Ot

Bibliography Options = % Remove Field Codes @' Preferences

Open RefWorks | Enable AutoSync Folder
Extras Settings

B
=
i
}
» |

_ On the Inse e galleries include items that are designed to coordinate with the overall look of
B your docum u can use these galleries to insert tables, headers, footers, lists, cover pages, and
other docum Iding blocks. When you create pictures, charts, or diagrams, they also coordinate

with your current document look.

You can easily change the formatting of selected text in the document text by choosing a look for the
selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls on the Home tab. Most controls offer a choice of using the look from the current

- theme or using a format that you specify directly.

To change the overall look of your document, choose new Theme elements on the Page Layout tab.
To change the looks available in the Quick Style gallery, use the Change Current Quick Style Set

’ command. Both the Themes gallery and the Quick Styles gallery provide reset commands so that you
= can always restore the look of your document to the original contained in your current template.

i At the point in the text where you want to add insert a reference
e 1. Place the cursor at that point

g 2. Use the space bar to add a space

I 3. Open the Insert Citation menu

4. Select Insert New

(£« 0 » 4

125% (=) [}
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File Home Insert Page Layout References Mailings Review View Developer Add-Ins RefWaorks A

nﬂ Style:  Harvard - L_@ Sync My Database 2! Log Out
E!, Bibliography Options = sy Remove Field Codes @' Preferences

cinion: 4 ey Opsge | 3 Opn v | [ it el To insert a reference continued:
L] B 1. Open the relevant folder
: 2. Click on the relevant reference

- 3. Click on OK

_ On the Inse e galleries include items that are designed to coordinate with the overall look of

B your docum u can use these galleries to insert tables, headers, footers, lists, cover pages, and

- other docum Iding blocks. When you create pictures, charts, or diagrams, they also coordinate |
J Insert/Edit Citation 22|

. ~1 Notin Folder ‘ | X

= _jArt&Elusiness )

a - Year Title i

- _] Coaching Culture

- ' Financial Management As a Determinant of

- e 2011 The Financial Management Behavior Scale: [ ~

n I 3

: ] Last Imported

- ﬂ Leader:h_lp Edit References |
o _:l M8A workshap DHide‘\’ear Suppress Pages DMake Footnote

- =] Real Estate [|Hide Author Override Pages: I:l [T] Biblicgraphy only

" ~1 RPG workshop Prefix: I:I Suffix: I:l

N _j Test Art & Business

- ) i Preview Citation [Hareard):

= ] Test migration

- ] Workshop (Dave 2012)

= Compose Citation

R Dave,Ashvin R., 2012, Financial Management As a Determinant of Profitability: A St...

'_ 4 L I

_ o
¥
ok

Page:10f1 | Words:186 | <& | IEE= 125% (=) Y]




psert Page Layout References Mailings Review View Developer Add-Ins RefWarks
Mvard - E@Sync My Database :-, Log Out
@,Bibliogra y Options = s Remove Field Codes @' Preferences
Insert )
Citation = ﬁB-ReappIyO put Style Open RefWorks Enable AutoSync Folder
Dew, Jeffery, 2011 hraphy Extras Settings
Dave,Ashvin R., 2012 ||-z-|-1-|-2-|-1-|-z-l-z-|-4-|-5-|-s-l-,?-l-s-|-9-|-1:--|-11-|-1z-|-1z-|-14-|-15-|-H\-|-1?-|-15-|

Insert Mew

include items that are designed to coordinate with the overall look of

ou can use these galleries to insert tables, headers, footers, lists, cover
ilding blocks. When you create pictures, charts, or diagrams, they also
document look.

= On the Insert g L=

- your docume
- pages, and ofger document

coordinate with your curren

You can easily change the formatting of selected text in the document text by choosing a look for the
selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls on the Home tab (Dew, Xiao 2011). Most controls offer a choice of using the look
from the current theme or using a format that you specify directly.

To change the overall look of your document, choosg
To change the looks available in the Quick Style galls e the Change Current Quick Style Set
command. Both the Themes gallery and the Quick Si ®allery provide reset commands so that you
= can always restore the look of your document to the original contained in your current template.

M heme elements on the Page Layout tab.

Inserting references continued:
1. Insert all relevant references through Insert Citation | Insert New
| navigate to folder | select reference | click OK

|| LT ——|
o @

» &
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ﬂ Style:

Insert
Citation = J’i Reapply Output Style
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ﬁ!, Bibliography Options =

Page Layout References Mailings Review View Developer Add-Ins RefWorks
Harvard - L_@ Sync My Database :, Log Cut
s Remove Field Codes @' Preferences
Open RefWorks Enable AutaSync Folder
Citation and Bibliography Extras Settings
20 0 11031314050 +6 171 8 9 1 10 [ - N - 15 1 L [T
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Insert/Edit Citation 23
]j Mot in Folder | |
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‘.j _usmess Author Year Title i
--{_] Coaching Cultu
Financial management practices and social r
3 Fi
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ont - Katie Stearm) ' K of
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yourl | ] Leadership Edit R_eferences _cover
pag{ | [ MBAworkshop H_|de‘1‘ear I'u!ak_e Footnote y also
coor ]j Real Estate Hide Author 5 Bibliography only
]j RPG workshop Prefix: |:| Suffix: I:I
You L Test Art & Busiy Preview Citation {Harvard): or th-e
sele| | 1.7 Test migration ' v using
;he -~{@ll Workshop (Tsai, Pan & Lee 2011, Morrill, Shawver & Kavanagh 2012) ook
rom
Toc Corpose Citation
Tog
Quig Tsai,Henry, 2011, Recent research in hospitality financial management
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File Home Insert Page Layout References Mailings Review View Developer Add-Ins RefWaorks ~ @
=ﬂ Style:  Harvard - L_@ Sync My Database 5! Log Ot
E!, Bibliography Options = % Remove Field Codes @' Preferences
Insert
Citation = ﬁ Reapply Qutput Style y Open RefWarks Enable AutoSync Folder
Citation and Bibliography Extras Settings
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_ On the Insert tab, the galleries include items that are designed to coordinate with the overall look of

B your document (Dave 2012). You can use these galleries to insert tables, headers, footers, lists, cover

- pages, and other document building blocks. When you create pictures, charts, or diagrams, they also |

coordinate with your current document look. 3
- You can easily change the formatting of selected text in the document text by choosing a look for the
selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using

7 the other controls on the Home tab (Dew, Xiao 2011). Most controls offer a choice of using the look

- from the current theme or using a format that you specify directly.

N To change the overall look of your document choose new Theme elements on the Page Layout tab.

= the look of your document to the original contained in your current template. B

- :

B o

- ¥
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Home Insert Page Layout References Mailings Review View Developer Add-Ins RefWorks ] @
gl Style:  Harvard : nc My Database :, Log Out

Hlmove Field Codes @' Preferences

(@ben RefWaorks Enable AutoSync Folder

Extras Settings
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_ On the Insert tab, the galleries include items that are designed to coordinate with the overall look of

- your document (Dave 2012). You can use these galleries to insert tables, headers, footers, lists, cover
pages, and other document building blocks. When you create pictures, charts, or diagrams, they also
coordinate with your current document look.

You can easily change the formatting of selected text in the document text by choosing a look for the
selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls on the Home tab (Dew, Xiao 2011). Most controls offer a choice of using the look
from the current theme or using a format that you specify directly.

To change the overall look of your document, choose new Theme elements on the Page Layout tab.

To change the looks available in the Quick Style gallery (Rajna et al. 2011), use the Change Current
Quick Style Set command (Tsai, Pan & Lee 2011, Morrill, Shawver & Kavanagh 2012). Both the

= Themes gallery and the Quick Styles gallery provide reset commands so that you can always restore
- the look of your document to the original contained in your current template.

To insert your bibliography/reference list:

1. Place the cursor at the end of your document where you want the list to start
2. Open the Bibliography Options menu
3. Select Insert Bibliography

Page:1 of 1 | Words: 204 | < |

1610 | |
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Check your reference list carefully — you may have to find the record in your main

RefWorks account and add information or amend the text
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_ On the Insert tab, the galleries include items that are designed to coordinate with the overall look of
your document (Dave 2012). You can use these galleries to insert tables, headers, footers, lists, cover
pages, and other document building blocks. When you create pictures, charts, or diagrams, they also
coordinate with your current document look.

You can easily change the formatting of selected text in the document text by choosing a look for the
selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls on the Home tab (Dew, Xiao 2011). Most controls offer a choice of using the look
from the current theme or using a format that you specify directly.

To change the overall look of your document, choose new Theme elements on the Page Layout tab.
To change the looks available in the Quick Style gallery (Rajna et al. 2011), use the Change Current

- Quick Style Set command (Tsail, Pan & Lee 2011, Morrill, Shawver & Kavanagh 2012). Both the
- Themes gallery and the Quick Styles gallery provide reset commands so that you can always restore
= the look of your document to the original contained in your current template.

- Dave, A.R. 2012, "Financial Management As a Determinant of Profitability: A Study of Indian Pharma
Sector”, South Asian Journal of Management, vol. 19, no. 1, pp. 124-137.

Dew, J. & Xiao, J.J. 2011, "The Financial Management Behavior Scale: Development and Validation”,
Journal of Financial Counseling and Planning, vol. 22, no. 1, pp. 43-59,85 .87

= Morrill, C.P_, Shawver, A & Kavanagh, S. 2012, "ASSESSING YOUR FINANCIAL MANAGEMENT
= ACUMEN", Government Finance Review, vol. 28, no. 3, pp. 8-11.

Rajna, A., Ezat, W.P.S., Al Junid, S. & Moshiri, H. 2011, "Financial Management Attitude and Practice
among the Medical Practitioners in Public and Private Medical Service in Malaysia", Infernational
Journal of Business and Management, vol. 6, no. 8, pp. 105-113.

Tsal, H Pan, S & lee J 2011, "Recent research in hospitality financial management”, [nfernational
= Journal of Contemparary Haspitality Management, vol_23. no. 7. pp.941-971.

T

un
o

Page:1 of 1 | Words: 345 | ¢4 | MEIEERE

(#) 4 0 » ¢

125% (=) [



Removing a reference — step 1

File Home Insert Page Layout References Mailings Review View Acrobat RefWarks ~ ®
ﬂ Style:  Harvard - L_@ Sync My Database :, Lag Out
ﬁ) Bibliography Options ~ % Remove Field Codes @‘ Preferences

Insert
Citation * ﬂ Reapply Qutput Style Open RefWorks | Enable AutoSync Folder

Citation and Eibliography Extras Settings

[T vy e X o112 131 40 51 g1+ 7 1B 19 1 40 i |12 1131141 15 AT e
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z On the Insert b, the gallerieff include items that are designed to coordinate with the overall look of
your documerll (Dave 2012). Wou can use these galleries to insert tables, headers, footers, lists, cover
pages, and ot wmai|ding blocks. When you create pictures, charts, or diagrams, they also
coordinate with your current document look.

You can easily change the formatting of selected text in the document text by choosing a look for the
selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls on the Home tab (Dew, Xiao 2011). Most controls offer a choice of using the look

- from the current theme or using a format that you specify directly.

;n_ To remove a reference from your text:
; 1. Highlight the reference then press delete on
your keyboard

- ournal or FHinancial -ounselng and

Flanning, vol. 22, no. 1, pp. 43-09,569,

l Morrill, C.P., Shawver, A. & Kavanagh, 5. 2012, "ASSESSING YOUR FINANCIAL MANAGEMENT
ACUMEN", Government Finance Review, vol. 28, no. 3, pp. 8-11.

Rajna, A, Ezat, WP .S Al Junid, S. & Moshiri, H. 2011, "Financial Management Attitude and Practice
among the Medical Practitioners in Public and Private Medical Service in Malaysia", International
Page:1of 1 | Words: 345 | \ﬁ | ||EIEE B 2
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Removing a reference — step 2

IE' H9-¢ = WNC-demo-Octl3.docx - Microsoft Word

Hame Insert Page Layout References Mailings Review View Acrobat Ref\Warks

Yo, s To remove a reference from your

bpen RefWorks #| Enable AutoSync Folder

& Style: Harvard

@Bibliography Cptions =

Citatio

Extras Settings

text:

3 @ Remove Bibliography
@ Format Bibliography

Press F1 for add-in help.

; 2.0pen Bibliography Options
N On the fhsert tab, thddgalleries include item menu and SeleCt Format
B

your doj ument[ You gan use these gallerig
. other dO‘wewmemsse#ding blocks. When you B b I h

: with your current document look. I I O g r ap y

You can easily change the formatting of selected tex e document text by choosing a look Tor the
selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using

the other controls on the Home tab (Dew, Xiao 2011). Most controls offer a choice of using the look
- from the current theme or using a format that you specify directly.

rite-N-Cite 4 ‘

To change the overall look of your document, choose new Theme elements on the Page Layout tab.

To change the looks available in the Quick Style gallery (Rajna et al. 2011), use the Change Current
- Quick Style Set command (Tsai, Pan & Lee 2011, Morrill, Shawver & Kavanagh 2012). Both the

= Themes gallery and the Quick Styles gallery provide reset commands so that you can always restore
the look of your document to the original contained in your current template.

Dave, A.R. 2012, "Figancial Management As a Determinant of Profitability: A Study of Indian Pharma
Sector”, South #sian Journal of Management, vol_ 19, no. 1, pp. 124-137.

Dew, J. & Xiao, J.J. §011, "The Financial Management Behavior Scale: Development and Validation”,
ial Counseling and Planning, vol. 22 no. 1, pp. 43-59,85,67.

l Morrill, C.P_, Shawver, A. & Kavanagh, S. 2012, "ASSESSING YOUR FINANCIAL MANAGEMENT
ACUMEN", Government Finance Review, vol. 28, no. 3, pp. 8-11.




Removing a reference — step 3

—
WHNC-demo-Octl3.docx - Microsoft Word = 22
[~]

Insert Page Layout References Mailings Review View Acrobat RefWorks

This window
displays a
preview of B

how this o S, A 212 ASSESSING YOURENANCIAL 1y
updated
version of your
bibliography

Harvard - L_@ Sync My Database :'-, Log Qut

Format Bibliography

bphy Options « 3 Remove Field Codes @ Preferences

Output Style Open RefWorks J| Enable Aut Preview:

m | »

Dew, J. & Xiao, J.J. 2011, "The Fmnancial Management Behavior Scale: Development and
Validation", Jowrnal af Financial Counseling and Planming, vol 22, no. 1, pp. 43-
59.85.87.
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Removing a reference - completed

Hame Insert Page Layout References Mailings Review View Acrobat RefWorks

Lﬂ Style:  Harvard - L_@ Sync My Database :, Log Out
ﬁ, Bibliography Options = % Remove Field Codes @' Preferences

Insert
Citation = ﬂ Reapply Output Style Open RefWorks J| Enable AutaSync Folder

Citation and Bibliography Extras Settings

_ On the Iisert tab, the @hlleries include items that are designed to coordinate with the overall ook of
your docliment. You cfin use these galleries to insert tables, headers, footers, lists, cover pages, and
other dof ildigh blocks. When you create pictures, charts, or diagrams, they also coordinate
with your current document look.

You can easily change the formatting of selected text in the document text by choosing a look for the
selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls on the Home tab (Dew, Xiao 2011). Most controls offer a choice of using the look
from the current theme or using a format that you specify directly.

To change the overall look of your document, choose new Theme elements on the Page Layout tab.

To change the looks available in the Quick Style gallery (Rajna et al. 2011), use the Change Current
N Quick Style Set command (Tsai, Pan & Lee 2011, Morrill, Shawver & Kavanagh 2012). Both the

= Themes gallery and the Quick Styles gallery prowde reset commands so that you can always restore
ment to the original contained in your current template.

Dew, J. & Xiao, J.J. 011, "The Financial Management Behavior Scale: Development and Validation”,
Journal of Finaggial Counseling and Planning, vol. 22 no. 1, pp. 43-59,85.87.

N Morrill, C.P., Shawver, A. & Kavanagh, S. 2012, "ASSESSING YOUR FINANCIAL MANAGEMENT
- ACUMEN", Government Finance Review, vol. 28, no. 3, pp. 8-11.

= Rajna, A, Ezat, W.P.S. Al Junid, S. & Moshiri, H. 2011, "Financial Management Attitude and Practice
= among the Medical Practitioners in Public and Private Medical Service in Malaysia”, International
Journal of Business and Management, vol. 6, no. 8, pp. 105-113.

The in-text citation has now disappeared along with the full reference in your bibliography.

Remember to save the changes.
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Some other features... “PABERDEEN

* Amend in-text citations directly in W-N-C

o add page numbers
O suppress author details

e Search for references

o Use the Search menu in your main account

* Share your database with others

o You can set up read-only access from within your main account



E™ UNIVERSITY OF

General housekeeping “P ABERDEEN

* Need to maintain your database
* Use it regularly — whenever you do searches on databases
* Remember to keep it neat — remove duplicate records

* Back up your records — available from the Tools drop-down
menu in your main account
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| already have a Word/Excel document containing a list of
references that | want to use. How do | get these into

RefWorks?

 There is a way of transcribing this data to push it into RefWorks but it is
time-consuming, a bit complicated and rather tedious — RefWorks help

screens provide more information

 We recommend finding the records in databases and exporting them
to RefWorks, or manually type or paste the information into RefWorks



To install Write-N-Cite on your own
computer

NIVERSITY OF
BERDEEN

For off-campus computers + laptops:

* Login to your main RefWorks account | Tools menu | Writing Tool Add-ons for
Windows or Mac

* Follow the installation guide available from the W-N-C installation window

 May have to install additional software (.NET 4 and Visual Studio 2010 Tools for Office
Runtime)

For networked/on-campus computers:

e Download W-N-C 4 software from the Software Download Service

e Available from www.abdn.ac.uk/staffnet/working-here/it-resources.php
 Will need ‘Admin Rights’ to do this yourself
* Contact the IT Service Desk for help to install the software



Your office PC on campus — WNC via the Software Center - 1

E O @&

Best match

Software Center
App

|

O software - see web results

Documents - This PC (1+)

Settings (2)

Maps

Microsoft Edge

Microsoft Office Tools

Microsoft Silverlight

Microsoft Store

Microsoft System Center
Software Center

Microsoft Teams

Mixed Reality Portal

Music, Photos and Videos

Notification Manager for Adobe Acr...

Notification Manager for Adobe Cre...

OneNote

OneNote 2016



Installing WNC on an office PC

Microsoft Silverlight

Microsoft Solitaire Collection I Software Center

Microsoft Store

New

Available Software Installation Status Installed Software Options
Microsoft System Center
Microsoft WiFi
: NAME

Mindjet 14 - Acrobat Pro DC

Adobe Acrobat Reader DC
Mindjet MindManager 2016 G9 Aleph Live client v22 [ ’

4 | Microsoft Language Pack UK

Mixed Reality Portal ®

S Panopto 6.0.0.56831
Mobile Plans (D) Snap 11 Professional Build 11.29

Money

(0 B ®

Check the Installed Software tab first. Is Java installed?

* |f no: click on the Available Software tab, find Java and
install it. (This must be carried out first.) Then install Write-
N-Cite.

* |f yes: install Write-N-Cite

Click on the Windows icon at the
bottom of the screen and click on
Microsoft System Center

Select Software Center



Installing WNC on an office PC

University of Aberdeen IT Services

Installation Status Installed Software Options

Show optional software
Find additional applications from the Application Catalog
[] NAME TYPE PUBLISHER AVAILABLE AFTER  STATUS -
] W SigmaPlot13 {Includes hotfix) Applicaticn 08/02/2016 Available
] M SingleCrystal Applicaticn CrystalMaker 08/08/2018 Available
[] = Tableau Reader 10.2 Applicaticn Tableau Software 26/03/2017 Available
[l #=Tinn-R Application Tinn-R Team 08/11/2013 fwvailable
O - Triplot 4.1.2 Application 17112007 Available
Ol é WLC Media Player v3.0.6 Application VideoLAMN 13/02/2019 Available
D Windows 10 1809 in-place upgrade with Office 365 Operating System 12/03/2019 Available
D & Windows Movie Maker Application Microsoft 22/07/2015 Available
|:| ‘Jy WinSCP w513 Application Martin Prikryl 03/04/2019 Available

[0 | Write-N-Cite 4.5.1732 Available
Write-N-Cite 4.5.1732 v
OVERVIEW REQUIREMENTS DESCRIPTION -
Status: Available Restart required: Might be required LOGIN USING GROUP CODE as previously supplied by RefWorks
Version: 451732 Download size: 16 MB . o B .
Date published: Not specified Estimated time: S minutes Write-N-Cite is a utility that allows users to run an abbreviated

version of RefWorks in Microsoft Word. You can access your
references by folder (or sub-folder), by quick search or by all
references with the ability to sort by author, title or year.

Help document: Click here Total components: 1

With Write-N-Cite. vou can cite references in @ manuscript with v




Downloading W-N-C on personal PCs

® Ref

Works

Language

Update Profile

Customize

Contact Us

Log out

University of Aberdeen
Welcome, ewanag.

, Advancead Search

Toals Search Your Database ‘uf:.u . Search
Writing Tool Add-ons additional Informati ‘
o New Folder E Create Bibliography s New SECHAnAL HOMnanon ~ Announcements
RefGrab-It 0
. i I ivE!a{:kup& Restore © Resources -
References > Last Imported | Support Center
Webinars
References | | Organize & Share Folders | fRR
References to Use B Sort by Change View
® Selected Page Allin List o v WA = e | aythors, Primary v || Standard View v Folders
: : My List
ReflD 4167 Generic Reference 1 of 3 ROk X . .
Mot In Folder ({95)
Authors, Primary EichnerER. -
Title, Primary Body Clocks, Jet Lag, and Sports Performance: The Times of Qur Lives # LastImported (3)
Source Current Sports Medicine Reports, 2020, 19, 1, 1-2 . . e
111 atest {11)
Folders Last Imporied;
RefID 4169 Journal Article Reference 2 of 3 — 11 aatest (3)
e ournal Article Reference 2 o RCI [ X
» 111 essay (5)
Authors Halson S.L.; Burke L.I.; Pearce J.
Title Mutrition for travel: From jet lag to catering 1111 11test (&)
Source |nt.J.Sport Mutr.Exerc.Metab., 2019, 29, 2, 228-235 P
. I 11123 (8)
Folders Last Imported; Y
: - 111alma primeo test (1)
ReflD 4168 Journal Article Reference 3 of 3 RO s[4 X | L1
1123 (1)
Authors Roberts 5.5 H ; Teo W.-P.; Warmington 5. A, B h
Title Effects of training and competition on the sleep of elite athletes: A systematic review and meta-analysis ;
Source BrJ Sports Med., 2019, 53, 8. 513-522 Quick Access
Folders Last Imported,;




Download W-N-C version 4

Writing Tool Add-ons

Do you have questions about the Iatest version Df Wnte N- How do | |Dg into Write-N-Cite 4 using my
Cite, Write-N-Cite 47 See our frequently asked questions. institution credentials?

If you use your institution's credentials (Athens, Shibboleth or
Proxy) to log in to RefWorks, you MUST copy and use this code
on the Write-N-Cite 4 login screen:

o New Folds

eferences
455d7d42507a46586150566040141F2751332311843221141 7002503518
41p5@22311083f1e3787@8061539152e325d3 a8 25ea5eeepd1dabs7 258d
Refe 82053093221 15373e68
s
=
®) Selected
Downloads
Re

huthors, Prini

Write-N-Cite 4.6 for 32 bit VWord

Title, Prin o
Sol For Windows 7., Windows &, and Windows 10
Fold Supports Word 2010, Word 2013, and Word 2016
R

uide

Mac or Window 5

Having trouble installing Write-N-Cite 470ur installation g
Auth might help, or you may need to check thig
T software requirements.

Soi
Folq .
R * Other Versions (1)
£ 1)
7 Write-N-Cite 4.6 for Word {Mac)
Auth )

For OS X 10.6 (Snow Leoparc_j'j: 10.7 (Lion), 10.8
Sol (Mountain Lion), 10.9 {Mavericks), 10.10 »

Folders Last Imporied; |




It’s the weekend and you’re stuck using RefWorks?

Language | Update Profile | Customize | Contact Us | Log oul

University of Aberdeen

. REfWO'rI(S Welcome, ewanag.

earch Your Database |‘£) . Search

Announcements

Tutorial
Additional Information

MNew Folder Create Bibliograph ) Mew Reference
¢ E L v “'Launch Help File

~y

B850

Resources B

References = Last Imported 7 Support Center
Webinars
References | | Organize & Share Folders | TR
References to Use B Sort by Change View
® Selected Page mintst = |© v &% &8 Aythors, Primary v | | Standard View v Folders s
: = My List
ReflD 4157 Generic Reference 1 of 3 (3C 7 X ) - ‘
Mot In Folder {95)
Authors, Primary  Eichner E.R. -
Title, Primary Body Clocks, Jet Lag, and Sports Performance: The Times of Our Lives # Lastimported (3)
Source Current Sports Medicine Reports, 2020, 19, 1, 1-2 111 atest (1)
Folders Last Imported;
: = 111 aa test (9)
RefID 41869 Journal Article Reference 2 of 3 RCI k[ X )

» 111 essay (5)

Authors Halson, 5.L.; Burke L.M.; Pearce,J.

Title Mutrition for travel: From jet lag to catering 1111 11test (&)
Source |Int.J Sport Nutr Exerc Metab., 2019, 29, 2, 228-2356 .
] I 11123 (8)

Folders Last Imported; -

RefID 4168 Journal Article Reference 3 of 3 C 111alma primo test (1)

- . A o 1123 (11)
Authors Roberts 5.5 H.; Teo W.-P.; Warmington S.A. i
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RefWorks Help and advice

* Library RefWorks web page:
www.abdn.ac.uk/library/support/information-skills-179.php#panel193

 RefWorks website for HELP file

 RefWorks YouTube videos www.youtube.com/user/ProQuestRef\Works



https://www.abdn.ac.uk/library/support/information-skills-179.php#panel193
http://www.youtube.com/user/ProQuestRefWorks

UNIVERSITY OF

RefWorks...the Future = ABERDEEN

 RefWorks have launched an updated version (=New o
e RefWorks

RefWorks) ,
 Completely new interface (a bit like Mendeley and others) | ’ =17
* New features aim to improve collaboration and sharing of T— )

resources between researchers Sk
* Other new features aim to simplify the research process from | %

beginning to end

* Looks nice, but it still has some bugs/faults and it does not
contain (yet!) all the features we think it needs to have for
users at your level

* We are working with and supporting the current version
(Legacy RefWorks) for 2019/20. More information on
any move to the new RefWorks will be publicised in
good time.



Using LaTeX rather than Word?

Can still use RefWorks as a place to store and organise your
references

You do not go on to use the RefWorks in-text and
bibliography generation tools in the same way as for a
Word document

Once all your references are in RefWorks you can generate
a file for export to BibTeX and then use that in your LaTeX
document

Build in extra time to your planning schedule to tidy up the
BibTeX file and make sure that you can sort out any
difficulties that may arise on the formatting side of things

>

UNIVERSITY OF
W ABERDEEN
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Using LaTeX rather than Word?

<P ABERDEEN

m  BibTeX for LaTeX general web page with links to support documents:

e https://www.imperial.ac.uk/admin-services/library/learning-
support/reference-management/bibtex-for-latex/

e This gives some general background information and links to specifically
Imperial College produced support documents and to the LaTeX community

s Useful support document - Using Legacy RefWorks with LaTeX

e www.imperial.ac.uk/media/imperial-college/administration-and-support-
services/library/public/legacy-RefWorks-with-LaTeX-sep-2017.pdf

m  Useful support document - Citing and referencing in LaTeX -using BibTeX

e www.imperial.ac.uk/media/imperial-college/administration-and-support-
services/library/public/LaTeX-and-BibTeX-apr-2019.pdf



https://www.imperial.ac.uk/admin-services/library/learning-support/reference-management/bibtex-for-latex/
http://www.imperial.ac.uk/media/imperial-college/administration-and-support-services/library/public/legacy-RefWorks-with-LaTeX-sep-2017.pdf
http://www.imperial.ac.uk/media/imperial-college/administration-and-support-services/library/public/LaTeX-and-BibTeX-apr-2019.pdf

RefWorks and Mac computers

@™ UNIVERSITY OF
w ABERDEEN

Important note:

The Write-N-Cite (WNC) plug-in for RefWorks does NOT currently work with Word 2016 on
Macs

RefWorks are working on a fix for this (in)compatibility issue — unfortunately there is little
that we can do to help until a solution is in place

* You can still store records in your main RefWorks account, but you cannot use the WNC
app to format them within Word 2016 when creating/writing a research paper or other
academic document

* If you have access to earlier version of Word — could use this with the WNC app for

creating/writing a research paper or other academic document that requires in-text
citations

An alternative is to use the One Line/Cite View method. Details available online in one of our
Library Guides: www.abdn.ac.uk/library/documents/guides/qgrfw008.pdf



http://www.abdn.ac.uk/library/documents/guides/qgrfw008.pdf

UNIVERSITY OF

Macs and Using One Line/Cite View

* An alternative for Mac users with Word 2016 is to use the One Line/Cite
View feature within RefWorks

* This allows you to insert citations and produce a bibliography/reference
list without the need to use Write-N-Cite.

* Details available online in one of our Library Guides:
www.abdn.ac.uk/library/documents/guides/qgrfw008.pdf



https://www.abdn.ac.uk/library/documents/guides/qgrfw008.pdf
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Going further

* Critical Appraisal of the Literature (Life & Physical Sciences)
 To be arranged (a December date is likely)

See the course booking system for details
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Help and support (1) BERDEEN

Library: Subject support

* Information Consultants & Information Adviser

 Subject & Enquiry staff (TSDRL floors 4-6, Medical and Taylor Libraries)

 Worksheets in our wiki (FinditFast!)
http://finditfastlibraryworkshops.pbworks.com

Access and IT:

e MyIT or Tel: 01224 27-3636 . Use phone for out of office hours (OOH) service
(17.00-08.00 on weekdays and anytime at the weekend)

e Email: servicedesk@abdn.ac.uk

 In person: Library, Floor 1 (lunchtimes are very busy!!) D



mailto:servicedesk@abdn.ac.uk

NIVERSITY OF

Help & support (2): Subject contacts BERDEEN

* Arts & Humanities
* Ewan Grant —e.grant@abdn.ac.uk

* Business & Law
e Janet MacKay —j.i.mackay@abdn.ac.uk

 Dentistry, Medicine & Medical Sciences
* Mel Bickerton — m.bickerton@abdn.ac.uk

e Education & Social Science
e Claire Molloy - c.a.l.molloy@abdn.ac.uk

* Engineering, Life & Physical Sciences
e Susan McCourt — s.mccourt@abdn.ac.uk

AL e L:‘sz

4

 General
* Eleni Borompoka —eleni.boro@abdn.ac.uk

https://www.abdn.ac.uk/library/support/contacts-106.php#panell162



https://www.abdn.ac.uk/library/support/contacts-106.php#panel162
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Help & support (3)

 Qur Find it Fast! wiki is a collection of resources designed to help you find good
qguality information quickly. It contains support materials such as slides from
workshop presentations and worksheets
http://finditfastlibraryworkshops.pbworks.com

* Our list of Library guides can be found at
www.abdn.ac.uk/library/support/library-guides-101.php

 For IT-related queries contact our colleagues at the IT Service Desk servicedesk@abdn.ac.uk



http://finditfastlibraryworkshops.pbworks.com/
http://www.abdn.ac.uk/library/support/library-guides-101.php
mailto:servicedesk@abdn.ac.uk
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Please complete the evaluation
form — feedback helps us to
improve what we offer!

Literature Searching: Part 3 ' A
Eleni, Janet & Susan



Library - Useful links
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Information skills workshops: www.abdn.ac.uk/coursebooking

Library homepage: www.abdn.ac.uk/library

Information Guides online: www.abdn.ac.uk/library/support/library-guides-101.php

Primo: http://primo.abdn.ac.uk

Information Consultants: www.abdn.ac.uk/library/support/contacts-106.php#panell162

Workshop materials - wiki: http://finditfastlibraryworkshops.pbworks.com

Email (general library enquiries): library@abdn.ac.uk

Library blog (InfolLinks): https://aberdeenunilib.wordpress.com

Library on Twitter: https://twitter.com/aberdeenunilib

Inter-Library Loan service: www.abdn.ac.uk/library/support/interlibrary-loans-182.php



http://www.abdn.ac.uk/coursebooking
http://www.abdn.ac.uk/library
http://www.abdn.ac.uk/library/support/library-guides-101.php
http://primo.abdn.ac.uk/
http://www.abdn.ac.uk/library/support/contacts-106.php#panel162
http://finditfastlibraryworkshops.pbworks.com/
mailto:library@abdn.ac.uk
https://aberdeenunilib.wordpress.com/
https://twitter.com/aberdeenunilib
http://www.abdn.ac.uk/library/support/interlibrary-loans-182.php
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Library - Useful links 9 ABERDEEN

Opening times
www.abdn.ac.uk/library/using-libraries/opening-hours-83.php#panell136

Library guides (all) www.abdn.ac.uk/library/support/library-guides-101.php

Library guides (referencing) www.abdn.ac.uk/library/support/library-guides-
101.php#R

Accessing e-resources www.abdn.ac.uk/library/documents/guides/ggdbs005.pdf

Remote access www.abdn.ac.uk/toolkit/systems/remote-access/

Materials from Library workshops http://finditfastlibraryworkshops.pbworks.com



http://www.abdn.ac.uk/library/using-libraries/opening-hours-83.php#panel136
http://www.abdn.ac.uk/library/support/library-guides-101.php
http://www.abdn.ac.uk/library/support/library-guides-101.php#R
http://www.abdn.ac.uk/library/documents/guides/qgdbs005.pdf
http://www.abdn.ac.uk/toolkit/systems/remote-access/
http://finditfastlibraryworkshops.pbworks.com/

1

" am UNIVERSITY OF
< ABERDEEN

Thank you

Please complete the
evaluation form




